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Overview 

PT Tracker is designed for use by Precision Teaching practitioners.  It can track the progress of 

multiple students and can track each student's progress in one or more skills.  The program tracks 

and displays timings over a period of up to 210 consecutive days.  If more than 210 days are 

needed for a particular skill, you’ll need to start a new skill for the student. 

PT Tracker stores all the data for a given student in one file.  Every time any data is changed for 

a student, the entire file is automatically saved.  The following information is saved in a student 

file: 

• First name 

• Last name 

• ID: The ID field is optional, and the user can decide its use and meaning.  For example, it 

could be used to distinguish two students with the same name, or two different files for 

the same student. 

• Skill(s): Each skill has its own name that you provide.  You can also specify: the time 

units for measurements (minutes, hours, days); the range of the y-axis; the number of 

days of data to collect (up to 210); and other parameters. 

• Timing(s): Each timing is associated with a skill and contains the timing date, duration, 

count and the number of errors. 

• Default skill: This identifies the skill displayed when you load the data for a student. 

The data for a student is stored in a file with this file naming convention: 

FirstName_LastName_ID.ptt 

For example, the data for student Jane Doe, whose ID is "23", will be stored in a file named 

Jane_Doe_23.ptt.  The data for student John Doe, who hasn't been assigned an ID, will be 

stored in a file called John_Doe_.ptt. 

 

Menus 

File Menu 

The following selections are available from the File menu: 

• Load student: Presents a file selection window so that you can choose a student file to 

load into PT Tracker. 

• New student: Displays the New Student screen to add a new student to the system (this 

will create a file for the new student). 

• Select skill: Changes the currently active skill. 

• New skill:  Displays the New/Edit Skill screen to add a new skill to the currently loaded 

student. 

• Edit skill: Displays the New/Edit Skill screen so that you can change the skill parameters 

(such as the skill name, the range of the y-axis, the number of days on the chart, etc.). 



• Set default skill: Allows you to choose a default skill from the current student's skill 

list.  The default skill will get displayed whenever a student's data is loaded into the 

program.  It will also be the pre-selected skill when you choose the Select skill option 

(above). 

• Edit timings: Displays the Edit Timings screen, which displays all the timings for the 

currently selected skill.  Allows you to add timings to the list, including for previous 

days.  Also allows you to delete and modify timings from the list. 

 

Google Menu 

The Google menu is only displayed when Google mode was activated at startup of PT 

Tracker.  See the section Google Mode for information about the Google menu. 

 

Tools Menu 

The Tools menu has these options: 

• Reset window size: Resets the size of the PT Tracker main window to its original size as 

of when the program started up. 

• Remove extra window space: When you resize the program in "SCC aspect ratio" 

mode, typically there will be extra space in PT Tracker's main window.  You can remove 

the extra space using this menu option. 

• Display log: Displays a list of messages that may help the programmer diagnose 

problems with PT Tracker.  After there are 100 messages in the log, older messages are 

deleted as newer messages are added.  The log is erased when the program terminates.  

 

Settings Menu 

When you change a setting via the Settings menu, PT Tracker automatically rewrites the settings 

file so that the updated setting will be the default the next time you start PT Tracker.  The menu 

items on the Settings menu are: 

• Change/save default database directory: Establishes a new directory for saving student 

files. 

• Change skill defaults: Brings up the New/Edit Skill screen so that you can edit/modify 

the defaults that are displayed whenever you make a new skill. 

• Use SCC aspect ratio: If this menu item is checked, PT Tracker will use the Standard 

Celeration Chart aspect ratio on all charts.  The SCC aspect ratio causes the x2 celeration 

line to have a 33-degree angle with respect to the horizontal axis. 

• Save current chart size: Use this option after resizing your chart to make it the new size 

the default size. 



• Logo options: Brings up the Edit Logo Display screen, which allows you to disable the 

logo or choose your own logo for displaying in the middle of the chart. 

• Change nomenclature: Brings up the Change Nomenclature screen.  Throughout this 

documentation and also in the program menus, error messages and dialog boxes, two key 

words are used: "student" and "skill".  If those words aren't appropriate for your situation, 

you can choose this menu option to select different words to use.  For example, you 

might prefer to use the word "client" instead of "student".  Note that, to change the word 

"Skill" that appears in the chart title, you need to change the "Chart Title" field in the 

New/Edit Skill screen. 

• Change Google Drive folder: By default, student files are not saved to Google 

Drive.  However, if you specify a Google Drive folder using this menu option, then the 

next time you start PT Tracker, it will attempt to save student files both to the local 

computer and to the Google Drive folder you specify.  Refer to the Google mode section 

for more information about automatically saving student files to Google Drive. 

 

Pop-up Menu 

If you right-click on the chart on the main screen, a one-option menu will appear giving you the 

option to save the chart to a .png file. 

 

  



Screens 

Main Screen 

 

On the main screen of PT Tracker, you can add timings for the current date and skill.  Just fill in 

these three fields: 

• Duration: The duration of the timing.  When you first add a new skill for a student, you 

will specify whether timings are in minutes, hours, or one day.  The duration is in 

whatever units were specified.  A timing of a half-minute would be entered as 0.5.  For 

day-long timings, "1" is the only allowable value for duration.  For hours, duration is 

specified as HH or HH:MM.  For example, 10:22 would be ten hours and 22 minutes. 

• Count: How many times the student performed the requisite task in the specified 

duration. 

• NumErrors: The number of errors made by the student during the timing. 

After filling in those fields, add the new timing to the current skill by either pressing the Enter 

key on the keyboard or clicking the Add Timing button on the main screen. 

On the semi-log chart, timings are displayed this way: 

• Duration:  Duration is displayed as a black, horizontal line at 1/Duration.  For example, 

if the duration is five minutes, there will be a horizontal line at 0.2. 



• Count:  Count is converted to count per time unit.  It will appear as a green-filled circle 

calculated at Count/Duration.  For example, if duration is two minutes and count is 182, 

there will be a green-filled circle at 91. 

• NumErrors:  NumErrors is converted to errors per time unit.  It will appear as a yellow-

filled rectangle at NumErrors/Duration.  For example, if duration is a half-minute and 

there are 2 errors, there will be a yellow rectangle at 4. 

 

New Student Screen 

 

The New Student screen contains three fields: 

• First Name: Required field. 

• Last Name: Required field. 

• ID: Optional field.  The user can decide its meaning.   For example, it could be used to 

distinguish two students with the same name, or two different files for the same student. 

When you click Save on the New Student screen, you will immediately be prompted to create a 

skill for the new student.  After that, the new student's data will be automatically written to that 

student's file even if you click Cancel on the New Skill screen. 

 

New/Edit Skill Screen 

 

 

 



The New/Edit Skill screen has these three uses: 

• Add a new skill for the currently loaded student (via the File Menu New Skill option). 

• Edit the currently selected skill of the currently loaded student (via the File Menu Edit 

Skill option). 

• Edit the skill defaults that appear whenever a new skill is created (via the Settings Menu 

Change skill defaults option). 

The New/Edit Skill screen has these three fields: 

• Skill name: An identifier for the skill. 

• Timing Units:  Can be minutes, hours or days.  (But the only allowable timing duration 

for "days" is 1 day.)  You can't change Timing Units after timings have been added to the 

skill. 

• Max Duration: This field is for error checking your timings.  PT Tracker will not allow 

you to enter a timing with a duration greater than Max Duration.  The format depends on 

what was specified for Timing Units, as follows: 

o Minutes: A decimal number.  For example, 40.5 

o Hours: Either HH or HH:MM 

o Days: Always 1 

• Y-Axis Min: The lowest value on the y-axis. 

• Y-Axis Max: The highest value on the y-axis. 

• Days in Chart: The number of days displayed on the chart.  You can choose a number 

from 70 to 210.  It must be a multiple of 7. 

• Chart Title: This description will appear before the skill name on the chart.  If you leave 

this field blank, the skill name will simply be displayed in parentheses. 

You cannot decrease Max Duration if some of the existing timings exceed the new duration. 

You can't increase Y-Axis Min if there is currently viewable data that would no longer be 

displayed on the chart with the new Y-Axis Min. 

You can't decrease Y-Axis Max if there is currently viewable data that would no longer be 

displayed on the chart with the new Y-Axis Max. 

You can't decrease Days in Chart if there is currently viewable data that would no longer be 

displayed on the chart with the new value of Days in Chart. 

 

  



Edit Timings Screen 

 

The Edit Timings screen has three purposes: 

• Display all timings for the current skill. 

• Add new timings for the current or a prior date. 

• Delete or modify timings. 

To add a timing on the Edit Timings screen, just fill in the four fields (Date, duration, Count and 

NumErrors) and press the Enter key or click the Add Timing button.  The duration field will be 

labeled Minutes, Hours or Days, depending on what was chosen for the Timing Unit when you 

set up the skill. 

To delete or modify a timing on the Edit Timings screen, double-click on the timing you want to 

delete or modify.  The Edit or Delete Timing screen will be displayed. 

A time stamp is associated with every timing.  The time stamp is always chosen automatically by 

the PT Tracker program; it is not possible for the user to choose it.  It is always set to the time of 

day at which the timing was added to PT Tracker, which is not necessarily the time of day at 

which the timing was performed.  If you use the Edit or Delete Timing screen to modify the date 

of a timing, its time stamp will be changed to the time at which the modification was performed. 

Every timing also has an associated day number (DayNo).  The day number is also determined 

automatically by PT Tracker.  Day zero, which is never used, is always the Sunday before the 

first timing. 

 

  



Edit or Delete Timing Screen 

 

The Edit or Delete Timing screen displays these fields of the selected timing so that you can edit 

them. 

• Date: The date the timing was done.  Format: MM/DD/YY or MM/DD/YYYY 

• Duration:  In the same units specified in the Timing Units field of the New/Edit Skill 

screen.  Cannot be greater than the Max Duration specified for its skill. 

• Count: A number greater than or equal to 0.  If Count is zero, it won't be displayed on the 

chart. 

• NumErrors: A number greater than or equal to 0.  If NumErrors is zero, it won't be 

displayed on the chart. 

The Edit or Delete Timing screen has three buttons: 

• Save Timing:  Saves the changes made to the timing. 

• Delete Timing: Deletes the timing. 

• Cancel: Returns to the Edit Timings screen without changing the timing.  The Cancel 

button is the default, so if you just click Enter on the keyboard, you'll cancel the Edit or 

Delete Timing screen without either saving or deleting the timing. 

 

Edit Logo Display Screen 

 

The Edit Log Display screen allows you to change the logo that is displayed in the middle of the 

chart.  The screen has these user inputs: 

• Logo Display Type: This option determines what logo will be displayed in the middle of 

the chart on PT Tracker's main window.  Options include: 

o Loco4Learning: Display the Loco4Learning LLC logo. 

o None: Don't display any logo. 



o User: Display a user-selected logo. 

• Opacity: This number from 0 to 1 controls how dark the logo will be.  If the value is 0, 

the logo will be invisible.  If the value is 1, the logo will have the full opacity of the logo 

image. 

• Pick Logo: Use this button to choose the logo to be displayed if the Logo Display Type 

is “User”. 

 

Edit Nomenclature Screen 

 

The Edit Nomenclature screen lets you change the words "student" and "skill" to something 

more appropriate for your use.  The words "student" and "skill" appear repeatedly in this 

documentation, in the menus, in the error messages and in the dialog boxes.  You can change 

those two words to something that makes more sense to you if you'd like.  The Edit 

Nomenclature screen has these six fields: 

• Client 

o Singular/NoCap: The singular form of the word that will replace "student" (not 

capitalized) 

o Singular/Cap: The singular form of the word that will replace "Student" 

(capitalized) 

o Plura/NoCap: The plural form of the word that will replace "students" (not 

capitalized) 

• Skill 

o Singular/NoCap: The singular form of the word that will replace "skill" (not 

capitalized) 

o Singular/Cap: The singular form of the word that will replace "Skill" (capitalized) 

o Plura/NoCap: The plural form of the word that will replace "skills" (not 

capitalized) 

After changing the nomenclature, PT Tracker menus, dialog boxes, feedback and error messages 

will use the newly specified words. 

Note that whatever you specify as "Client-Singular/Cap" will appear in the title of the chart in PT 

Tracker's main window.  However, to replace the word "Skill:" on the chart, you need to change 

the "Chart Title" field of the New/Edit Skill screen. 

  



Specifying the Database Directory 

PT Tracker saves student data in files that have the .ptt file extension.  When you first install PT 

Tracker, the location of the student data files is set as follows: 

• Windows: The "Start in" directory, which is typically the directory where PT Tracker is. 

• Mac OS: The user's Documents directory. 

It is likely that neither of these default locations are desirable for your particular use.  If that is 

the case, on your first use of PT Tracker, you should use the Change/Save default data directory 

option of the Settings menu to change the data directory to be its own dedicated location. 

 

Settings File 

Usually, you will never have any need to look at the settings file.  PT Tracker automatically 

creates, reads, and writes it as follows:  

• On startup, PT Tracker creates a new settings file if the file doesn't exist where it is 

supposed to be.  It fills the file with "factory defaults".  

• If the settings file exists on startup, PT Tracker reads it and uses its contents as defaults 

during the session.  

• Whenever you change a setting via the Settings menu, PT Tracker rewrites the settings 

file. 

The location of the settings file depends on the operating system, as follows:  

• Windows: The settings file is in the user's Documents directory.  

• MacOS: The settings file is in the user’s Library/Preferences directory.  

The name of the settings file also depends on the operating system, as follows:  

• Windows: .pt-tracker.txt  

• MacOS: com.loco4learning.PT-Tracker.txt  

 

Auto-archive 

Every time PT Tracker saves a student file, it also creates an archived version of it.  The archived 

versions are saved in a subdirectory of the database directory called archive.  Every archived file 

has the archive date in its name so that the last version saved on any given day will be available 

on subsequent days.  After three weeks, archive files are automatically deleted.  There is 

currently no automated way to recover archived data, but it can be done manually using the 

operating system's file management commands.  Here are the general steps to follow: 



• If the invalid student file still exists in the database directory, rename or delete it. 

• Copy the appropriate archive file to the database directory. 

• Rename the copied archive file, removing the hyphen and the date after the hyphen. 

For example, let's say something bad happens to the student file John_Smith_.ptt.  Delete it or 

rename it.  Then copy an appropriate archive file to the database directory.  For example, you 

might want to restore the data from October 29, 2021, so you would copy the file called 

John_Smith_-2021-10-29.ptt.  Then rename that file to be John_Smith_.ptt. 

 

Google Mode 

Overview  

To support teachers who teach their students from different computers – perhaps one at home 

and one at work – PT Tracker offers the capability to automatically save student files to Google 

Drive whenever they are updated on the local machine.  Then, when the teacher needs to access a 

file saved from a different computer, the student file can be downloaded from Google Drive 

using the Download student file menu option on the Google menu. 

PT Tracker's use of Google Drive is designed to protect all the other files you have placed on 

Google Drive.  See Data Privacy/Security and File Sharing with other Users for a description of 

how PT Tracker protects your other files. 

"Google mode" is disabled by default.  To enable Google mode, you need to select the Change 

Google Drive folder option of the Settings Menu.  There, you will specify the Google folder ID 

of the Google folder where you want to save your student files.  After specifying the folder ID, 

you must exit PT Tracker and start it again.  See Configuring the Google Drive Folder ID for 

instructions on obtaining the folder ID. 

 

Google Mode User Interface  

Auto-save of Student Files  

Recall that PT Tracker automatically saves a student file to the local computer every time student 

data is changed.  When in Google mode, whenever PT Tracker successfully saves a student file 

to the local drive, it also automatically uploads a copy of the file to Google Drive.  If for some 

reason, PT Tracker is unable to upload a copy of the file, it will display an error message and put 

the data in a queue to be uploaded later, if the problem can be fixed.  NOTE: The queue is erased 

when PT Tracker terminates.  

Specifying Google Account and Permissions  

The first time you start up PT Tracker in Google mode, Google will use your default web 

browser to prompt you to:  



• Specify a Google account that PT Tracker will use.  

• Give PT Tracker permission to "View and manage Google Drive files and folders that 

you have opened or created with this app."  

After the first use, PT Tracker and Google will typically remember your selections and it usually 

won't be necessary to specify them again on subsequent uses of PT Tracker.  However, if you 

wish to change them, you can use the Return to Google sign-in screen option of the Google 

Menu to repeat the sign-in and permissioning sequence. 

Google Menu  

In addition to automatic uploads to Google Drive, the following options are available on the 

Google menu when in Google mode:  

• Download student file:  Displays a list of all the student files in the Google Drive 

Folder.  You will have the option of downloading one of those student files.  If there is a 

file by the same name in the currently active database directory of the local computer, the 

downloaded file will replace it.  After the file is downloaded to the local computer, the 

downloaded student data will be displayed. 

• Upload student file:  Displays all the student files in the currently selected local database 

directory.  You will have the option of uploading one of those files to the Google Drive 

Folder.  As with automatic uploads, if an error occurs while uploading the file, an error 

message will be displayed and the data will be placed in a queue for later uploading if the 

problem can be fixed. 

• Return to Google sign-in screen: Allows you to re-specify the Google account you want 

PT Tracker to use.  In your default browser, Google will also ask you again whether you 

want to give PT Tracker permission to save and read Google Drive files (as described 

above in the section Specifying Google Account and Permissions). 

• Cancel attempt to sign-in to Google: Usually, when PT Tracker accesses Google Drive, 

the operations are relatively quick.  However, the sign-in process depends on user input, 

and so it can take a long time, or the user can make a mistake and cause PT Tracker to 

wait forever for a user response.  When this happens, you can use the Cancel attempt to 

sign-in to Google menu option to terminate the sign-in process. 

• Disable/Enable Google interface: This menu item disables Google functions.  When the 

Google interface is disabled:  

o You won't be able to use other Google menu items until you re-enable the Google 

interface.  

o Any time PT Tracker automatically saves a file to the local computer, it will add 

the data to the queue for later uploading to Google.  Again, remember that the 

queue gets erased when PT Tracker terminates, so if there is anything in the queue 

on termination, it will not have been saved to Google Drive.  

Google Status Display 

In Google mode, the status of the Google interface is always displayed in the lower right-hand 

corner of PT Tracker.  The status consists of a filled in circle whose color indicates the current 

status.  Possibilities include:  



• Green: PT Tracker successfully connected to Google.  Student file uploads (both 

automatic and requested) and downloads should succeed.  

• Yellow: Google sign-in is in progress.  You need to respond to the Google authorization 

request in your default browser.  

• Orange: A Google Drive operation (other than sign-in) is in progress.  These operations 

usually finish quickly unless there is an internet glitch.  These operations include:  

o Uploading a student file  

o Downloading a student file  

o Verifying that the Google Drive Folder is valid for saving files.  This operation is 

performed automatically at start-up, after signing in again, and whenever a new 

Google Drive Folder ID is specified (via the Change Google Drive folder menu 

option of the Settings menu).  

• Red: PT Tracker did not successfully connect to Google.  No file uploads or downloads 

can be performed. Auto-saves to Google Drive will be queued.  You will need to use the 

Return to Google sign-in screen option on the Google Menu to make the status turn 

green.  

• Gray: Google interface disabled.  Auto-saves to Google Drive will be queued.  You will 

need to re-enable the interface via the Enable Google interface menu option in order to 

resume uploading and downloading student files. 

 



Save Queue  

In Google mode, if for some reason PT Tracker is unable to upload a student file to Google 

Drive when required, a copy of the file is added to an internal "save queue" so that it can be 

uploaded as soon as possible.  PT Tracker attempts to upload the data in the save queue 

whenever any Google Drive operation is successfully completed.  This means that the queued 

student data will be uploaded after a successful sign-in to Google on behalf of PT Tracker. 

Whenever there are items in the save queue, an ugly yellow button will be displayed in the lower 

right-hand corner of PT Tracker.  This ugly button serves as a warning that data has not been 

uploaded.  If you click on the button, a list of the queued student files will be displayed.  When 

this list is displayed, if PT Tracker believes that it might be possible to successfully upload the 

files, it will also offer an option to attempt an upload of the queued data.  

The save queue is lost when PT Tracker terminates, so any student files that are in the queue 

when PT Tracker terminates will not get uploaded to Google Drive.  

 

Configuring the Google Drive Folder ID 

Every Google Drive file and folder has a unique ID that never changes throughout the life of the 

folder or file.  You can rename the file, move it to another folder, or delete it; it will still have the 

same ID until it completely disappears from Google’s system.  To use PT Tracker’s Google 

mode, you need to obtain the unique folder ID of the Google Drive folder where you want to put 

your student files. 

To get the folder ID and enable Google mode in PT Tracker, perform the following steps:  

• Create a Google Drive folder to hold the PT Tracker files.  

• Obtain the Google Drive file ID of the folder.  You can do this as follows:  

o Sign in to Google Drive.  

o Find the folder you created for PT Tracker files.  

o Right-click on the folder name to display a Google menu.  

o Select the Get Link menu item.  

o Google will display a link that looks something like this:  

▪ https://drive.google.com/drive/folders/1DQ3zj9axvaof5w1ZAeMLzym5X

RLxkGaC?usp=sharing  

o The file ID is everything between the last forward slash and the question mark.  

▪ In this example, it would be: 

1DQ3zj9axvaof5w1ZAeMLzym5XRLxkGaC  

o Copy the file ID of the folder (but not all the other stuff in the link).  

• Start PT Tracker  

o Go to the Settings menu and choose Change Google Drive folder.  

o In the dialog box, paste in the file ID.  

o Exit PT Tracker and restart.  

 



Data Privacy/Security and File Sharing with other Users  

PT Tracker uses a special Google Drive access permission that ensures the safety and privacy of 

all the user's other Google Drive files.  Before PT Tracker can access your files on Google Drive, 

Google opens a tab in your default browser and asks you: 

1) What Google account do you want to use for PT Tracker’s access to Google Drive, and 

2)  Do you want to give PT Tracker permission to "View and manage Google Drive files 

and folders that you have opened or created with this app." 

Here are some things to know about this mode for accessing Google Drive: 

• By using this mode, PT Tracker will not be able to access files that it didn't create. 

 

o There is one exception: PT Tracker will be able to create, modify and delete its 

own .ptt files in the Google Drive folder you specify using the procedure in 

section Configuring the Google Drive Folder ID. 

 

• PT Tracker can only read or overwrite files created while signed in to Google with the 

same account that created those files.  PT Tracker won't even be able to see/read files 

created via another Google account, even if they are in the same directory and even if 

they were created by PT Tracker. 

 

• PT Tracker can access a shared Google Drive folder if the specified Google account has 

Editor privileges on the folder.  However, again, if different Google accounts put files 

into a shared folder, PT Tracker will only be able to see/read the files created under the 

same account that wrote them.  

A user of PT Tracker can be confident that the program will not be able to read or write any 

Google Drive files but its own and the folder you specify.  This restriction is enforced by 

Google, not by PT Tracker. 

 

Sharing Google Drive Student Files with other Users 

All the privacy restrictions can make it problematic to share student files with another Google 

Drive user.  If other people need to use PT Tracker to access the same student files on Google 

Drive, everyone needs to use the same Google login.  In that case, I suggest that you create a new 

Google account specifically for when people use PT Tracker.  They would then sign in to that 

account when PT Tracker starts up and Google asks for your permission to let PT Tracker access 

Google Drive.  

 

 

 



Alternative to Google Mode 

The purpose behind Google Mode is to write student files to the cloud so that they can be 

accessed from anywhere.  There are probably other ways to accomplish this, although I haven’t 

personally tested them. 

There is software available that can make cloud files and folders appear as if they are on the local 

computer.  I believe Dropbox and Google both offer software to do this.  You would then set the 

Database Directory to be a cloud-based folder established by one of these vendors. 

One disadvantage of this type of solution is that if you lose your internet connection, you will 

also lose your ability to look at and update the student data.  (Some vendors may also have a 

solution for that too, by maintaining both local and cloud versions of the files.) 


